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Microsoft Entourage offers an integrated solution, with e-mail, calendar, address book, 
directory, tasks, and notes – all rolled into one program. Microsoft also offers a web interface 
called Outlook Web Access (OWA). OWA 2003 has the same look and feel as the desktop version 
of Outlook. Using Entourage is like having both Eudora and CorporateTime in one application, 
with a shared address book; or using the OWA, is like having Webmail and CorporateTime for 
the Web together in one web client. 

People often interchange “Outlook” and “Exchange”. Outlook is really a combined e-mail and 
calendar client – similar to the separate clients of Eudora and CorporateTime. Exchange is the 
mail and calendar server, where the messages and appointments are stored. Currently we have 
separate e-mail (blue.weeg.uiowa.edu) and calendar (calendar.uiowa.edu) servers. 

Some examples of things you can do with Entourage are: 

• Send, receive, and store e-mail messages.  
• Maintain a personal calendar of appointments, events, and meetings.  
• Schedule meetings and check who will be attending.  
• Create a contact, note or appointment directly from an e-mail.  
• Get a reminder before a meeting.  
• Store, organize, and share names, addresses and other information about your business 

and personal contacts.  
• Filter junk e-mail and systemize e-mail messages you wish to keep.  

 
Starting Entourage   Return to Top 
  

1. Open the Hard Drive on your computer.  
2. Go to Applications | Microsoft Office 2004.  
3. Select Microsoft Office Entourage 2004.  
4. Select the Identity Name from the list, if applicable.  
5. Type your Password, if prompted.  
6. Click OK, if necessary.  
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  Default Navigation 
Pane Buttons What they will display

  
Mail Favorite folders and all mail folders list. E-mail folders that 

you use frequently can be added to your favorite folders list. 

  
Calendar View your calendar. 

  
Contacts View and manage all the contacts folders you can open – 

whether stored on your computer or on a network location. 

  
Tasks View and manage things you need to perform or personal or 

group projects you are managing. 

  
Notes View electronic “sticky or post-it notes” which store text 

information. 

  
Project Gallery New Project Gallery in Entourage 2004 
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Entourage has an on-line Help feature.  

Select Help | Entourage Help.  

For immediate assistance, you can call the ITS Help Desk at 384-HELP. 

If you have access to the Web, check out the ITS Exchange web page at 
http://www.its.uiowa.edu/cs/exchange/. Entourage documentation is available. 
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Do one of the following to start a New Message: 

1. Open the Mail Pane by doing one of the following:  
o From the View Menu I Go To I Mail  
o Click the Mail icon from the Navigation Pane 

2. Start a new message by doing one of the following:  
o On the Standard toolbar, click the New button  
o Press Command + N  
o From the File menu choose New then select Mail Message  

3. Type an e-mail address in the To... field.  
4. Press Tab or click in the field and type in the Cc... field e-mail address (optional).  
5. Press Tab or click in the field and type in the Bcc... field e-mail address (optional).  
6. Press Tab to move the cursor to the Subject: field.  
7. Enter the subject of your message (optional but highly recommended):  

o At a minimum the subject should: 
* Let you see, at a glance, the main topic of the e-mail. 
* Help you distinguish legitimate e-mail from spam. 
* Help you track an e-mail conversation as it develops.  
* A good subject line should be short and to the point, but not so short that it is 
cryptic.  

8. Press Tab to move to the body of the message.  
9. Type your message.  
10. Click the Send Now button.  

Tip: You can type multiple addresses in the To..., Cc..., or Bcc... fields, as long as you 
separate them with semicolons (e.g., its-helpdesk@uiowa.edu; tom-doe@uiowa.edu; jane-
doe@uiowa.edu) 
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You can use the Global Address Book to look up and select names, e-mail addresses, and 
distribution lists when you address messages.  

http://www.its.uiowa.edu/cs/exchange/
mailto:its-helpdesk@uiowa.edu
mailto:tom-doe@uiowa.edu
mailto:jane-doe@uiowa.edu
mailto:jane-doe@uiowa.edu


When you type a name in the To, Cc, or Bcc box of an e-mail message, Microsoft Entourage will 
automatically try to match the name to a name in the address book. If there is a match, the 
name is resolved — the Display Name and e-mail address are filled in — allowing you to send 
the message. If there is no match, the Check Names dialog box prompts you for more 
information or you can create a contact by clicking New Contact. If more than one name 
contains the letters you typed, you can select a name from the list. 

In addition to using the Address Book to address messages, you can look up names and other 
information, such as office locations and telephone numbers, by typing the name in the Find a 
contact box on the Standard toolbar (toolbar: A bar with buttons and options that you use to 
carry out commands. To display a toolbar, click Customize on the Tools menu, and then click 
the Toolbars tab.). 

Several types of address books can be displayed in the Address Book: 

Global Address List (GAL) 

This feature requires you to be using a Microsoft Exchange Server e-mail account. 

The Global Address List contains the names and e-mail addresses of everyone on the UI 
Exchange server. It can also contain global distribution lists and public folder e-mail addresses. 
The Microsoft Exchange Server administrator creates and maintains this address book from 
Active Directory. Departmental Lists will automatically be pulled from Active Directory.  So 
each department will no longer have to maintain their lists and new hires will be added 
automatically. Subsets of the Global Address List are displayed in the Address Book when you 
choose an entry under All Address Lists on the Show names from the list. You can download the 
Global Address List for use offline. 

When you double-click on a name in the GAL you can view the properties for that person. This 
will display more in depth information about the person such as their phone number and office 
location. You can add people from the GAL to your Address Book.  

Entourage Address Book 

The Entourage Address Book is created automatically and contains the contacts in your 
Contacts folder that have a contact entry in the E-mail or Fax boxes. These contacts display in 
the Address Book dialog box when you click Contacts in the Show names from the list.  

Auto Complete 

When you start to type an e-mail address or name in the To..., Cc..., or Bcc... address boxes 
Entourage Auto Complete will suggest a list of possible matches drawn from names or addresses 
you have typed in before. Use the Down and Up Arrows to select the name you want and then 
press the Return Key to have it entered in your address field. Of course you may manually type 
an address also.  
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The Global Address List is a list of all accounts on the University of Iowa Exchange Server. 

1. Type the name you want to search for in the To->, Cc->, or Bcc-> fields and click on 
the Check Names button.  

2. Click the user name to select it from the list.  
3. Click the Done button.  
4. Repeat until all user names are added.  
5. Finish the email.  
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The following are 3 ways to save a message in progress. 

• With the message open | on the File menu select Save. 
      Or  

• With the message open | click the red circle button in the upper right corner of the 
window.  
You will be asked if you want to save the message. Click Yes. 
      Or  

• With the message open | on the File Menu select Close. 
You will be asked if you want to save the message. Click Yes. 

Note: Messages are saved in the Drafts folder. Double-click the saved message to open it for 
editing. 
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Entourage includes a built-in spelling checker. It can be used to check for misspellings in the 
body of current message composition windows, text files, and signature files. It includes a 
built-in dictionary and also allows for the creation of a custom user dictionary. By default, 
when you are typing a message, the spell checker will look for misspellings. If you wish to turn 
this off, choose Entourage | Preferences | Spelling and deselect “Check spelling as you 
type”. You would then need to follow the steps below to perform manual spell checks.  

1. To check the spelling of a current composition window, text file, or signature file, do 
one of the following:  
• Select Tools | Spelling 

(If text is selected, Entourage checks only the spelling of the selected text.)  
2. If a misspelled, unknown, or repeated word is found, the Check Spelling dialog is 

displayed with words listed in the Suggestions.  
3. Click on the correct spelling or type your correction over the misspelled word. Click 

Change to change the spelling or Ignore to keep the current spelling or if the word is 
spelled correctly but not in the Entourage dictionary click the Add button.  

4. A dialogue box will pop up telling you when Spell Check is complete click OK.  

Note: If you mistype a word but the result is not a misspelling (for example, “from” instead of 
“form” or “there” instead of “their”), the spell checker will not flag the word. 
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By default messages are sent immediately. You can change this from Immediate send to 
Queued by the following: 

1. Click Send Later for the message you want to queue. 
2. Click the Send & Receive button when you want to send the messages. 

This will send all messages in the Outbox from any account that is included in the Send/Receive 
Groups. 

Note: If you have the account set to automatically send & receive, the message will be sent 
automatically.  Queued messages are stored in you Outbox until they are sent. Once a message 
has been sent it can be found in your Sent Items folder. 

See Include Account in Send/Receive to be sure messages from your account is sent when you 
click the Send button. 
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1. For those who check more than one e-mail account. Do one of the following:  
o On the Tools menu | select Schedules | Double-click Send/Receive All | 

Define Send/Receive Groups  
2. Under Actions change . .  
3. If you’d like Entourage to automatically send and receive, place a check next to 

Schedule an automatic send/receive every ## minutes. You can choose how often.  
4. Click OK.  
5. Click Close.  

Note: Exchange updates your Inbox as soon as a message arrives.  
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• To check all e-mail accounts:  
o Click the Send/Receive button on the Standard toolbar. 

• To check one individual account (if you have more than one configured) do one of the 
following:  

o Click the drop down arrow to the right of the Send/Receive button 
then select the account you want to Send/Receive from the list or type the 
number in front of the account name. 

Note: New mail will show up in the Inbox for the account it was received for. Unread 
messages will appear in bold text in the View pane. Double-click on the message to 
open it. 
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Entourage allows you to preview a message in 2 ways: 

1. See the entire message in a different window: 
o Double-click the message  

2. Preview the content of any item in the Preview Pane:  
o From the View menu  
o Select Preview Pane  
o Then Select Right or Bottom. (select None to hide the Preview Pane)  
o Then Select the message to in the View Pane and see it in the Preview Pane 

In the Preview Pane, you can read the content of an item, open attachments, follow a 
hyperlink, view the follow-up information in the InfoBar (InfoBar: Banner near the top 
of an open e-mail message, appointment, contact, or task. Tells you if a message has 
been replied to or forwarded, along with the online status of a contact who is using 
Instant Messaging, and so on.), and respond to meeting requests. 

Note: The Preview Pane and AutoPreview settings are set for each folder separately. 
The Preview Pane does work for the Drafts folder, but you cannot edit it there. 
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1. With the message open or selected in the mailbox,  
2. Do one of the following:  

o Click the Reply or Reply to All button on the Standard toolbar 
      Or  
o Press Command + R (reply)  

Or  
o Command + SHIFT + R (reply to all)  

Or  
o Choose Message | Reply or Reply to All 

3. A new message will be created that contains the contents of the original message. The 
Subject line will be the same as the original with ‘RE: ‘ added in front of it.  

4. The Reply button will address your response to the Sender of the message only.  
5. The Reply to All button will address your response to the Sender of the message and to 

everyone listed in the To... and Cc... fields.  
6. You may add or remove recipients in the same manner as you would a new message.  
7. Add any additional text you want then click the Send button.  
8. The message will be sent automatically. 
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1. With the message selected (highlighted) or open  
2. Do one of the following:  

o Click the Forward button on the Standard toolbar 
      Or  
o Press Command + J (forward).  

Or 
o Choose Message | Forward. 



A new message will be created that contains the contents of the original message. The Subject 
line will be the same as the original with ‘FW: ‘ added in front of it. 

3. You may add or remove recipients in the same manner as you would a new message.  
4. Add any additional text you want then click the Send button.  
5. The message will be sent Automatically.  
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• In the Folder Contents list  
1. Select the message you want to transfer  
o Press Shift + Command + M 

Or  
o Select Message | Move To.  
2. Click on the folder you want to move your message to and click OK.  
3. Drag and Drop the message to the folder you want to move it to. 

Tip: You can create a new mailbox and transfer a message into it all in one step. Instead of 
selecting an existing mailbox, select New...  

Tip: If you transfer a message and decide you put it in the wrong mailbox, select Edit | Undo 
Move.  
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1. Select or open the message you want to print.  
o Select File | Print.  

      Or  
o Control-click on the message | choose Print from the drop down menu  

      Or  
o Click the Print button on the Standard toolbar.  

2. Click OK.  
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There are many ways to delete a message or messages, as follows:  

*** Be sure you are selecting the message and not the Folder itself. 

• Select the message(s) you want to delete in the Folder list then select Edit | Delete 
Message.  
      Or  

• Open the message(s) you want to delete then select Message I Move To I Move To 
Folder....  
      Or  



• In an open mailbox window, select the message(s) you want to delete. Press the Delete 
key.  
      Or  

• Select or open the message(s) you want to delete. Select Move to Folder Icon (pic 
here) | Deleted Items. 
      Or  

• Select or open the message(s) you want to delete. Click the Delete button on the 
Standard toolbar.  

Note: All deleted messages are moved to the Deleted Items folder.  

Warning: Items in the Deleted Items folder still count against your Quota. See Empty the 
Deleted Items Folder and Empty the Deleted Items Folder on Exit to learn how to empty the 
folder. 
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Manually empty the Deleted Items folder as follows:  

• On the Tools menu, point to Run Schedule, and then click Empty Deleted Items 
Folder. 
      Or  

• Control-click on the Deleted Items folder | select Empty “Deleted Items” Folder from 
the pop up menu | Answer Yes to confirm Delete of items and subfolders in the 
Deleted Item Folder.  
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• From the Tools menu | select Run Schedule | select the Edit Schedules | select 
Empty Deleted Items Folder I then Edit I under When click on the drop down menu 
and choose On Quit I then Okay 
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After reading a message, you may want to mark is as unread to keep it in your unread mail 
folder for future action. 

Any of the following will mark a message as unread: 

• While in the Folder List | Control-click on the message and choose Mark as Unread. 
      Or  

• While in the Folder List with the message highlighted | from the Message menu | 
choose Mark as Unread. 
      Or  

• While in the Folder List with the message highlighted | Press Shift + Command + T.  
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If you have a file that you wish to include with an outgoing message, you can do so by adding 
an attachment to your message.  
From your New Message window, click on the Attach button in the Tool Bar. This will display a 
new window (shown below) where you will be able to navigate to and choose the file you wish 
to attach. Once you have located and selected the file, click the Choose button at the bottom 

of the window.  
 
Doing this will add a new field to the top of your message, titled Attachments. You will then 
see your file listed in this section. If you wish to add more files to the message, repeat the 
process explained above.  
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If you receive a message with an attachment you would like to view, select the attachment you 
would like to view and click Open or Save(as shown below) on the right hand side.  Removing 
the attachment is only an option for POP or IMAP connections. 

 

Note: If Entourage doesn’t know which application to use or the application is unavailable, it 
will bring up a directory window and ask you to locate the application. 

Note: Attachments in Entourage are part of the message. When you delete a message in 
Outlook the attachment is also deleted. Any attachments you want to keep will need to be 
saved per the instructions above. Attachments also count against your quota while the message 
is in your mailbox on the Exchange server. 



Warning: Some file extensions are blocked by Exchange as they are tagged as being potentially 
unsafe, for example, files with a .exe extension. You will need to ask the sender to rename the 
file to a different extension or use a packing program such as StuffIt and then resend it. When 
a file is blocked a shaded warning box will appear in the Infobar of the e-mail explaining 
“Exchange blocked access to the potentially unsafe attachments: filename” Do NOT open files 
of these types unless you expect or are expecting to receive them. 
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If someone sends you a URL (Uniform Resource Locator) in a message, you can hover your 
mouse pointer over the URL to see the address it is directed to (if it is different from the link 
showing). You can click on the URL (e.g., http://www.its.uiowa.edu/cs/email ) to open the 
web location (provided you have a web browser such as Netscape or IE and have access to the 
web via the campus network or through an Internet Service Provider).  

Note: When entering a URL into an e-mail you need to add a space at the end of the URL to 
make it live (i.e. clickable). 
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To change your Password for Outlook you must change your HawkID password on the Change 
HawkID Password Page at https://hawkid.iowa.uiowa.edu/password/apr.dll/change
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If you would like to add a new contact to your Address Book, click the New button in the 
Address Book Tool Bar, and enter any contact information you wish to retain in the fields 
provided, as displayed here:  

http://www.its.uiowa.edu/cs/email
https://hawkid.iowa.uiowa.edu/password/apr.dll/change


 
When you have entered all contact information you wish to save, click the Save & Close button, 
which will return you to your Address Book window. 
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If you often send messages to the same group of people, it may be beneficial to create a Group. 
In order to do this, you must first be in the Address Book screen. From there, click on the Add 
Group button. Doing so will display the following window:  

 
In this window, you will create the name of your Distribution List in the field provided for 

Group Name. From there, you will need to add the names of contacts you would like 
added to this list. Manually type the Display Name and E-mail Address in the fields 
provided.  When you are finished adding names, click the close button, click Save, and 
you will be returned to your Contacts window.  

 



Note:  These, like Distribution Lists, first appear as just a group, not individuals when 
scheduling or sending an email.  To see the individuals control-click on the group and 
select expand group. 
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To automatically add a signature to your outgoing message, select Tools | Signaures from the 
Menu Bar. This will open a new window. From here, click the New button. Choose a name for 
your signature and click in the field for the signature. Enter the information you wish to be 
displayed in your signature in the space provided. Once you have created your signature, click 
the Red Close button at the top, click Save at the subsequent screen. Finally, close the 
Signatures window and you will return to the Navigation Pane.  

Note: A different signature may be selected for each account you have setup. 

Note: You may change your default signature from within an e-mail message. Right-click on 
the Signature then Select a different signature from the Pop-up list. You can also choose to 
type over a signature or highlight it and delete it. 
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There is not an option in Entourage to turn on the Vacation Message on the Exchange 
Server.  However, you can use the OWA instead. 

1. Login to the OWA (http://email.uiowa.edu) 

2. Click on the options button. 

3. Turn on Out of Office Assistant. 
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Use colors to flag messages from or to a particular person. 

1. Select a contact in your address book.  
2. Select Categories (pic here) or Edit I Categories   
3. Select the appropriate category. 
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Use flags to remind yourself to follow up on an issue or to indicate a request for someone else. 
You can also use flags to set a reminder for the message or contact. 

There are many ways to flag a message, as follows:  

• While in the Folder List | Control-click on the message and choose Flag. 
 

http://email.uiowa.edu/


• With the message open | On the Standard toolbar click the Red Flag | then select the 
Flag for Follow-Up. Fill out the options and Close the window.  

The quickest way to find these messages again is in your Task view.  

Note: If you choose Add Reminder then set a Due by: date and time a reminder will pop up for 
the message at the assigned time. 
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Sometimes you may want to create additional folders to store some messages in. Entourage lets 
you create Folders and Sub-Folders. 

 To create a new Folder do one of the following:  

o Select File | New | New Folder 
      Or  

o Click the down arrow on the New button then select Folder 
      Or  

o Control-click on your folder list and select New Folder 
      Or  

o Press Apple + Shift + N 
2. Type the name you wish to give your folder.  
3. Select where you want the folder placed i.e. Your mailbox, a sub-folder to your Inbox 

or where ever you want it to go.  
4. Click OK  

Note: You can move messages into the new folder by clicking and dragging them. See 
Transferring Messages between Folders and Sub-folders for more information. 
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1. To do a Simple Find do one of the following:  
o Select Edit | Find  

      Or  
o Press Apple + F 

      Or  
o Type the subject or other options in the Search dialogue box.  

2. Type the text you want to search for in the Find: dialog box  
3. Select the Folders you want to search in the Messages: drop down dialog box  
4. Click Find.  
 
 
1. To do an Advanced Find do one of the following:  

o Select Edit | Find | Advanced Find  
      Or  

o Press Ctrl + Shift + F  
      Or  



o Click the Find button on the Standard toolbar | then click the Options button 
and select Advanced Find  

2. Fill in your information in the dialog box.  
3. Click Find Now.  
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• Sort your messages on a single field by clicking on the Column Heading  
o Click the column heading once to sort the list in Ascending Order  
o Click the column heading a second time to sort the list in Descending Order  

Or 

• Do the following:  
1. Select View | Arrange By  
2. Select the field you want to sort by  

**You can choose Show in Groups from the Arrange By menu also. For example 
if you sort by date then show in groups you will see messages grouped from 
Today, Yesterday, Last Week, etc.  
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Select Entourage | Quit Entourage to exit from Entourage.  
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The Exchange 2003 Outlook Web Access interface looks and feels almost the same as the 
desktop version of Outlook.  

1. type this address in your email browser https:\\email.uiowa.edu  
2. Enter your domain and user name: ex. iowa\username  
3. Select your security preference - Public\shared computer or Private computer. 

(Choosing Private computer changes the timeout time to 24 hours.) 
4. Click the Log On button.  



 

Note: The premium interface looks and behaves almost exactly the same as the desktop install 
of Outlook. You can even right-click on some items to get a cursor sensitive drop-down menu.  
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ITS Help Desk  
Phone: 384-HELP (4357)  
E-mail: its-helpdesk@uiowa.edu 
Location: 15 Lindquist Center South  
http://www.its.uiowa.edu/cs/helpdesk  
ITS Exchange Support  
http://www.its.uiowa.edu/cs/exchange

mailto:its-helpdesk@uiowa.edu
http://www.its.uiowa.edu/cs/helpdesk
http://www.its.uiowa.edu/cs/exchange
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